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Learning outcomes

❑Become familiar with the CSD
❑How to use Mercury for Particle Informatics studies.
❑How to use the Surface Analysis tool.
❑How to calculate Full Interaction Maps on surfaces.
❑How you can best use Mercury and CSD-Particle in your 

workflows.
❑About recent advances and improvements in CSD-Particle tools.

We will make the 
recording available to you 

in the next few days.



Agenda

• Show One: Introduction to the CSD, CSD-Particle and Particle 
Informatics

• Show One: Case study by Prof. Elena Simone
• Show One: Surface Analysis using CSD-Particle
• Try One: Hands-on examples
• Explore More: Case studies, tips, quiz and summary
• Extra time: More time for hands on and Q&A

We are recording today's 
session and will make the 
recording available to you 

in the next few days
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Publication year

The Cambridge Structural Database

Structures 
published 
that year

Structures 
published 
previouslyCSD Refcode: JEKNOC16. 

The 1.25 millionth CSD 
structure determined in 2023. 

1 3 8 2 2 7 2

The millionth CSD structure.

Structure determined 
by Yao Wang and his 
team in 2019

XOPCAJ

• Small molecule organic 
and metal-organic 
structures 

• Every published structure
• Inc. ASAP & early view

• CSD Communications

• Patents

• University repositories

• Thesis

• Every entry enriched and 
annotated by experts

• Discoverability of data and 
knowledge

• Sustainable for 60 years
• A trusted CoreTrustSeal 

repository



CSD Refcodes

What is JEKNOC16?
• A CSD Refcode
• A database reference code
• Containing 6-8 characters
• Used to identify entries in the CSD

Refcode families
• The same substances are assigned the same 6 letter code plus an additional 2 numbers

• Polymorphs
• New determinations or re-refinements of the same substance
• Determinations at different temperatures/pressures 

• Stereoisomers or different solvates, co-crystals, etc are assigned different refcode families

CSD Refcode - 
JEKNOC16

Some interesting refcodes are: KITTEN, BATMAN, DISNEY, GAUTAM, GLYCIN



Statistics in the CSD

Data collected using 
the CSD Python API 
and graphs created 
with Flourish From our 

#CSDLeaderboard 
at conferences!habit label

colour label



Search, visualise, analyse and communicate structural data
Insights into molecular and crystal shape and interactionsCSDCore.

Medicinal & Computational Chemists  Crystallographers & Structural Biologists  Solid Form & Crystallisation 
Scientists  Functional Materials Scientists  Educators  Industry and Academia

Deposit, publish, access and visualise structural data
Free functionality to share and learn from structuresCSDCommunity.

Design of new molecules Generate solid form 
landscapes

Anticipate particle 
properties and behaviour

2 Donors
2 Acceptors

Assessment of solid form 
stability and properties

CSDDiscovery. CSDMaterials. CSDParticle. CSDTheory.

The CSD Portfolio
C
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Mercury



What can you do with a licence?

• Supporting research: The CSD Portfolio 
enables bulk access to the CSD and large-
scale structural surveys to advance your 
research.

• Responsible data use: We encourage and 
support use for research and analysis, but 
redistribution and large-scale publication are 
restricted to protect the CSD’s sustainability.

• Publication guidelines: Small extracts and 
visualizations can be shared, as can refcode 
lists but full datasets require permission. 

• Supporting you: More information is 
available on our website, but if in doubt, 
contact us—we’re happy to help!

https://www.ccdc.cam.ac.uk/solutions/csd-licence/                                      support@ccdc.cam.ac.uk

https://www.ccdc.cam.ac.uk/solutions/csd-licence/
https://www.ccdc.cam.ac.uk/solutions/csd-licence/
https://www.ccdc.cam.ac.uk/solutions/csd-licence/


Agenda

• Show One: Introduction to the CSD, CSD-Particle and Particle 
Informatics

• Show One: Case study by Prof. Elena Simone
• Show One: Surface Analysis using CSD-Particle
• Try One: Hands-on examples
• Explore More: Case studies, tips, quiz and summary
• Extra time: More time for hands on and Q&A

We are recording today's 
session and will make the 
recording available to you 

in the next few days



Why does particle shape matter?

• The shape of a particle can impact:
• Pharmaceutical solubility and stability.
• Packing behaviour.
• Flowability.
• Processing and manufacturing efficiency/ability.

• CSD-Particle and data-driven design can 
help to:
• Anticipate manufacturing bottlenecks.
• Guide formulation decisions.
• Predict particle shape and properties.

Paracetamol

Have you ever 
wondered why 

paracetamol 
tablets are so large?



The field

Particle

Product

Process-
abilityPerformance

Product
Particle Sticking &

Flowability 
Wettability & 
Compaction 

CSD

Cost



From solid form to particle properties

Molecule Form Particle Properties
Solid Form Informatics

Particle Informatics



Analysing particle properties

M. J. Bryant et al., Cryst. Growth Des. (2019), 19, 9, 5258-5266. ISSN 1528-7483

Slip Planes
Surface 

Properties Morphology

• Ongoing research projects into particle and surface phenomena are developing our 
understanding of formulation and manufacturing processes.

• Application of rapid, informatics-based approaches to understand the link between 
crystal structure and properties that influence downstream behaviour.



Agenda

• Show One: Introduction to the CSD, CSD-Particle and Particle 
Informatics

• Show One: Case study by Prof. Elena Simone
• Show One: Surface Analysis using CSD-Particle
• Try One: Hands-on examples
• Explore More: Case studies, tips, quiz and summary
• Extra time: More time for hands on and Q&A

We are recording today's 
session and will make the 
recording available to you 

in the next few days

Prof. Elena Simone

Politecnico di TorinoPlease add your questions for 
Prof. Simone in the chat and she 

will answer either in writing or 
verbally during the hands-on part.



Agenda

• Show One: Introduction to the CSD, CSD-Particle and Particle 
Informatics

• Show One: Case study by Prof. Elena Simone
• Show One: Surface Analysis using CSD-Particle
• Try One: Hands-on examples
• Explore More: Case studies, tips, quiz and summary
• Extra time: More time for hands on and Q&A

We are recording today's 
session and will make the 
recording available to you 

in the next few days



Which surface to analyse?

How do crystals grow?
• Depends on relative growth rates

• Rhkl

• Faster growing faces are smaller

• Growth rates are dependent on 
many things:
• Supersaturation
• Solvents
• Impurities

R = rate
hkl = to indicate direction of growth



BFDH morphologies

• Simplest morphology model.
• Essentially based on unit cell.

• Point molecules.
• Growth rates inversely proportional 

to distance between Miller planes.
• Layer-on-layer growth.
• Independent of growth 

environment.

A. Bravais, Études Crystallographiques, Gauthier-Villars, Paris, (1866).
M.G. Friedel Bull. Soc. Franc. Miner. (1907), 9, 326-455.
J.D. Donnay, D. Harker, Amer. Min. (1937), 22, 446-467.

BFDH =  Bravais-
Friedel-Donnay-Harker 



VisualHabit

• Uses a range of simple forcefields to 
calculate lattice, slice, and 
attachment energies.

• Integrated into Mercury and 
interfaces with other tools in the 
CSD-Particle suite.

• Developed through a collaboration 
with the University of Leeds 
supported by a Knowledge Transfer 
Partnership.

G. Clydesdale, R. Docherty, K. J. Roberts, Comput. Phys. Commun. 1991, 64 (2), 311–328. 
https://doi.org/10.1016/0010-4655(91)90040-R 

https://doi.org/10.1016/0010-4655(91)90040-R
https://doi.org/10.1016/0010-4655(91)90040-R
https://doi.org/10.1016/0010-4655(91)90040-R
https://doi.org/10.1016/0010-4655(91)90040-R
https://doi.org/10.1016/0010-4655(91)90040-R


Accessing morphologies in Mercury



BFDH Morphology

Display Options 

Save and Load 

Learn more on 
BFDH Morphology 
in the Glossary in 

the handout.



Accessing VisualHabit

Input Results

Convergence



Bonus: Experimental Habit Data Field



Surface Analysis 

Surface Roughness 

Surface Chemistry 

Surface Charge 



Surface Analysis

M. J. Bryant et al., Cryst. Growth Des. (2019), 19, 9, 5258-5266
Alexandru A. Moldovan and Andrew G. P. Maloney Crystal Growth & Design 2024 24 (10), 4160-4169



Surface Analysis

Descriptors

Physical Chemical

Reticular Surface 
Area

Hydrogen Bond 
Donor/Acceptor 

Density

Rugosity
Aromatic Bond 

DensityRMSD, Skewness, 
and Kurtosis

Statistically Derived Interaction Data
H-bond donor H-bond acceptor

Aromatic bond



Descriptors

Physical Chemical

Reticular Surface 
Area

Hydrogen Bond 
Donor/Acceptor 

Density

Rugosity
Aromatic Bond 

DensityRMSD, Skewness, 
and Kurtosis

FIMs on Surface

Particle Informatics



CSD-Particle – Surface Analysis

Input 

Extra TIP: also launch directly from VisualHabit



CSD-Particle – Surface Analysis

Results 

Learn more about 
these parameters 
in the Glossary in 

the handout.



Display Options 

CSD-Particle – Surface Analysis



CSD-Particle – Surface Analysis

Advanced Options



Full Interaction Maps (FIMs)

• Map interaction preferences 
around complete molecules in a 
crystal structure

• Visualise observed atom-atom 
contacts with respect to likely 
geometries in 3D space

• Identify interaction hot-spots 
around chemical groups

• The maps are built from the 
knowledge in the CSD by observing 
the relative position of interacting 
chemical groups 

hydrogen-bond 
donor

hydrogen-bond 
acceptorhydrophobic 

interactions

Learn about 
FIMs in this 
free online 

CSDU course



FIMs Algorithm

Wood P. A., et al. CrystEngComm (2013) 15, 65-72.

Match and overlay 
scatterplot for each 

probe

Learn about 
FIMs in this 
free online 

CSDU course



FIMs on Surface 

FIM Surface FIM on Surface



CSD-Particle – FIMs on Surface

Full Interaction Map 
on Surface 



Accessible from the CSD Python API

• All CSD-Particle functionality is in the CSD Python API 
• Carry out automated large-scale analysis 
• Develop further methodologies utilising underlying 

data. 

• Share your analysis via our code repository 

https://github.com/ccdc-opensource/csd-python-api-scripts

Your Script API Our 
Libraries

Learn more about  
our CSD Python API 

in CSDU on-
demand course



Mercury Overview

AABHTZ

Explore over 
1.3 million 
curated 

structures

More advanced 
functionality to analyse 

and learn from structures

v

Display 
options to 

visualise and 
navigate 

structures

Learn more in 
this free online 
CSDU course

Self-guided 
exercises



AQOLAVAABHTZ

Lots of display and
analysis options!

Watch the 
video on 
creating 

personalised 
styles

New



AQOLAVAABHTZ

Lots of display and
analysis options!

Watch the 
video on 
using voids 
and other 
functionality 
for porous 
materials



Using your own file or from the web
• File > Open – to open one of your own files for example a CIF
• Edit > Auto Edit Structure to assign bond types
• File > Auto Edit Structure on Load to automate



Solvate Analyser

• Calculation and display of the 
space occupied by each of the 
different solvent molecules

• Easy selection of solvent 
molecule(s)

• Assessment of any hydrogen 
bonding motifs to/from the 
solvents

• Obtain reports
• Works with disorder feature 

producing different results based 
on the disorder group selected



Lost toolbars?

Type in a refcode

v

Extra Tip
Click on the resize 

icon or drag the top 
to pop the toolbar 

out.

Extra Tip
To pop the toolbar 

back in drag it to the 
area you want it.



AABHTZ

Reset 
button: 
a friend!

New in 2025.1!



Click on “Default 
definition” to 
change the 

default H-bond 
definition

HXACANVisualising hydrogen bonds



Visualising hydrogen bonds

HXACANLeft click on the 
atoms at the end 

of the dashed lines 
(known as 

hanging contacts) 
to expand the 

network

Right click on 
hanging contacts 

to see more 
advanced options 
including delete 

hanging contacts

Tip - Change H-bond thickness by
Display>Styles>Contact settings…

Tip - Change H-bond colours by
Display>Colours>Contacts…

>colour by distance>All contacts



Agenda

• Show One: Introduction to the CSD, CSD-Particle and Particle 
Informatics

• Show One: Case study by Prof. Elena Simone
• Show One: Surface Analysis using CSD-Particle
• Try One: Hands-on examples
• Explore More: Case studies, tips, quiz and summary
• Extra time: More time for hands on and Q&A

We will make the 
recording available to you 

in the next few days.

After the session you can 
earn a completion 

certificate for today by 
taking our test.

REC



Using Surface Analysis with disordered 
structures

We learnt more about disorder in the previous Virtual Workshop!

CSD refcode: 
PYRZIN19

(100) surface

• Visualise the different disorder 
models

• Works in combination with other 
functionality in Mercury



Calculating planes



Slicing



Features for effective visualization

• Create files for 3D print

• Create high resolution 
images and frames for 
video or gifs

Print with your 3D printer 
or at a 3D printing service!

Example of 3D 
printed 
structure of 
CSD Refcode 
SAHYIK



Generating high quality images

• File > POV-Ray Image
• Change Resolution

• Width = 4000
• Height = 3000

• Change ‘Material 
Properties’ to 
‘Metallic’

• Set ‘Background’ to 
‘Transparent’

•  Press ‘Preview’



Optimising display settings

AHIHAC (011)[0.00] – default settings

Turn ambient 
light off

Surface opacity at 70%



A wealth of structures, stories and possibilities

CSD one million special issue
• 33 articles from industry and academia

The CSD - A wealth of knowledge gained from a million structures. CrystEngComm, 2020,22, 7131-77502
The CSD. C.R.Groom, I.J.Bruno, M.P.Lightfoot and S.C.Ward, Acta Cryst. (2016). B72, 171-179 DOI: 10.1107/S2052520616003954

Legacy and Future Impact of the 
Cambridge Structural Database: A 
Tribute to Dr. Olga Kennard - special 
issue
• 29 articles from industry and academia



More case studies



How to cite the tools seen today

• Surface Analysis
Surface Analysis─From Crystal Structures to Particle Properties
Alexandru A. Moldovan and Andrew G. P. Maloney
Cryst. Growth Des. 2024, 24, 10, 4160–4169
https://doi.org/10.1021/acs.cgd.4c00259

• Mercury
Mercury 4.0: from visualization to analysis, design and prediction
C. F. Macrae, I. Sovago, S. J. Cottrell, P. T. A. Galek, P. McCabe, E. 
Pidcock, M. Platings, G. P. Shields, J. S. Stevens, M. Towler and P. A. 
Wood, J. Appl. Cryst., 53, 226-235, 2020
[DOI: 10.1107/S1600576719014092]

• CSD
The Cambridge Structural Database
C. R. Groom, I. J. Bruno, M. P. Lightfoot and S. C. Ward, Acta Cryst. 
(2016). B72, 171-179
DOI: 10.1107/S2052520616003954

More reference 
papers for

CSD-Particle

More reference 
papers for

CSD Software

https://doi.org/10.1021/acs.cgd.4c00259
https://doi.org/10.1107/S1600576719014092
http://dx.doi.org/10.1107/S2052520616003954


What we have learnt

✓Become familiar with the CSD
✓How to use Mercury for Particle Informatics studies.
✓How to use the Surface Analysis tool.
✓How to calculate Full Interaction Maps on surfaces.
✓How you can best use Mercury and CSD-Particle in your workflows.
✓About recent advances and improvements in CSD-Particle tools.



Want to explore more?

https://www.ccdc.cam.ac.uk/community/training-and-learning/

CSDU

• Free
• Completion certificate upon 

passing a final test.
• In-depth review of today’s 

topics and more software.

Self-guided
workshops

Training and learning

• Covering use cases with guided 
examples.

• Including examples from today 
as well as other CSD Software.

Learn on demand 
with free online 
training courses

CSD 
Python 

API

Basics of
Mercury

Full 
Interaction 

Maps

Videos

YouTube 
channel

And more!

REC



Want to explore more?

CCDC Virtual Workshops
• 4th November – How to Use the Docking 

Software GOLD to Perform Virtual 
Screening Simulations

CCDC Webinars
• 13th November - Using general purpose 

force fields in solid form studies

• 20th November, Panel – Frontiers in MOFs: 
Creating Real-World Solutions with MOFs

Check our Events online for more 
virtual and in person events.



Technical and scientific support

Visit the FAQs on the 
website

https://support.ccdc.cam.ac.
uk/support/solutions

See the documentation in 
Support and Resources on 

our website
https://www.ccdc.cam.ac.uk/supp

ort-and-resources/

Getting set up
Technical support

Scientific questions

License queries
Renewals

Find out license 
contacts

Email 
admin@ccdc.cam.ac.uk

Contact our support team
https://support.ccdc.cam.ac.uk

/support/tickets/new
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